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1 Ready-or-Not overview

1.1 Background

Repairs to the emissions-control systems of a 1996 or
@ newer (OBD-Il) vehicle cause the vehicle's computer
(ECU) memory to be cleared. The vehicle must go through
CHECK adrive cycle to allow the ECU to perform a series of tests to
ensure that the repair was successful, and before a state mandated

emissions test can be conducted.

Modern vehicles lack equipment to indicate whether the tests have
been completed. As a result, often times the customer will bring the
vehicle back to the repair shop for retest before all the required tests
by the ECU are complete. This causes the vehicle to be rejected from
testing because the computer is not ready, leading to lost time and
frustration to both the customer and the technician.

The purpose of the Ready-or-Not test tool is to provide an easy way
for automotive technicians to determine whether an OBD-II vehicle is
ready for an emissions test. The device can be loaned to a motorist to
aid them in knowing when to return for testing.

1.2 Features

e Easy to install and use. The Ready-or-not test tool plugs
directly into the vehicle's diagnostic connector, and displays
readiness status within seconds.

e Durable. Designed for shop use, the test tool features a shatter-
proof enclosure, and an easy to replace connector/cable.

e Compatible with all OBD-ll compliant vehicles (1996 and
newer model years).

e No batteries required. The device is powered from the
vehicle's diagnostic connector.

e Visual indicators. There is a total of eight easy-to-read LEDs,
including "Ready" and "Not Ready" LEDs, and six monitor
status LEDs.

e Built-in speaker produces an audible tone every thirty seconds
when the vehicle is ready for testing.

e Software configurability allows the test tool to be adapted to
any existing or future state emissions program. The configura-
tion utility supplied with the test tool comes with a large number
of presets, covering all current state emissions programs.

e Flash memory means the test tool can be easily upgraded with
new features and will never become obsolete.
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1.3 Package contents

Ready-or-Not unit
OBD-Il cable
Serial cable
Software CD

This user guide
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If any of the items are missing or damaged, please contact Customer
Support (see section 7, "Support Information").

1.4 Interface elements

Monitor Status LEDs

© Ready
© Not Ready

© Not Supported PC Connector

DB9 Female
OBD connector
DB9 Male
A
C e ) ]
['4
e < g
= 4
5% 8 5 5 ¢
O O O O O O
C O O ]

READY NOT READYJ

v

Readiness Status LEDs l

(@) O  Steady green: ready

@) ©  Steady red: not ready
9 ©  Flashing green: standby
O ©  Flashing red:

Slow: connecting
Fast: error (see Appendix A)
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2 Install the configuration
utility

Software configurability makes the Ready-or-Not an extremely
versatile device. Using the supplied configuration utility, the unit's
behavior can be modified depending on the requirements of a
particular state emissions program.

2.1 System requirements

The supplied Ready-or-Not configuration utility can be installed on
virtually any computer running the Windows operating system.

¢ 80486 processor or above
¢ 16Mb of RAM

e Windows 95 or above

¢ 640x480 display or better
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2.2 Run setup

1. Prior to running Setup, close all open programs, including any
antivirus software.

2. Insert the software CD into the CD-ROM drive. The software
installation menu will automatically appear within a few moments:

Ready-or-

Install Configuration Utility
Ready-or-Not™ User Guide

If the menu does not appear, click Start->Run, type E:\setup.exe
(where E is the drive letter of your CD-ROM drive), and click OK.
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3. Click on "Install Configuration Utility" to launch the Setup
program.

B Ready-or-Not Config 1.0 Setup [B[EE

Welcome to the Ready-or-Not
Config 1.0 Setup Wizard

This wizard will guide you through the installation of
Ready-or-Not Config 1.0

It is recommended that you close all cther applications
before starting Setup, This will make it possible ko update
relevant system files without having to reboot your
cormputer.

Click Mext ta continue.

Cancel

4. Click "Next". You will be presented with the License Agreement
dialog.

License Agreement
Please review the license terms before instaling Ready-or-Nok Config 1.0,

Press Page Down to see the rest of the agreement,

FOFTWARE LICENSE AGREEMENT FOR. SCANTOOLNET SOFTWARE ~

ITHIS SOFTWARE IS OW/MED BY SCANTOOL.NET LLC OR ITS SUBSIDIARIES AND IS
PROTECTED UNDER COPYRIGHT LAWS AND INTERMATIONAL COPYRIGHT TREATIES,
ITHIS SOFTWARE IS LICENSED, NOT SOLD. THIS SOFTWARE IS PROVIDED UNDER THE
IFOLLOWING LICENSE WHICH DEFINES WHAT YOU MAY DO WITH THE PRODUCT AND:
(CONTAINS LIMITATIONS ON WARRANTIES AND{OR REMEDIES.

IMPORTANT: CAREFULLY READ THIS LICENSE BEFORE LISING THIS PRODUCT.
INSTALLING, COPYING, OR OTHERWISE USING THIS PRODUCT INDICATES YOLR v

IF you accepk the kerms of the agreement; click 1 Agree to continue, You must accept the
agreetmert to Install Ready-or-hot Config 1.0.

[ <msck |[ 1agree | [ concel |

5. After reviewing the License Agreement, click "I Agree" to indicate
your acceptance of the license terms, and to proceed with the
installation.

Choose Install Location

hoose the folder inwhich to install Ready-or-Not Config 1.0,

Setup will install Ready-or-Not Config 1.0 in the following Folder. Ta installin a different
Folder, click Browse and select another folder, Click Next to continue,

Destination Folder

Brows

Space required: 691,0KB
Space available: 56,568

<Back || Wea» | [ cancel
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6. Choose the installation directory (or keep the default directory),
and click "Next".

B Ready-or-Not Config 1.0 Setup
Choose Start Menu Folder
Choose a Start Menu folder for the Ready-or-Mat Config 1.0 shorteuts.

Select the: Start Meriu Folder in which you would ke to create the program's shortzuts, You

can also enter a name to create a new folder,

Accessories
Acministrative Tools
Startup

[ <gack ][ mstal | [ concel |

7. Choose the Start Menu folder for the Ready-or-Not shortcuts (or
keep the default folder), and click "Next." The installer will copy
the program files and configuration presets, then display a dialog
indicating the successful completion of the installation.

B Ready-or-Not Config 1.0 Setup

Installing
Please wait hile Ready-or-ot Config 1,0 is being installed.

=)
!’..
=
5]
o
3
=
Q
c
=
=
<

Extrack: UT - Davis - 1999 and newer.ran

Extract: WA - 1996 to 2000.ron,., 100% ~
Extract: ¥T.ron... 100%

Extract: ¥i - 2001 and newer.ron... 100%

Extract: ¥i - 1996 ta 2000.ron,., 100%

Extract; UT - Weber - 2001 and newer.ron.., 100%
Extract: UT - Weber - 1998 to 2000100, 100%

Extract: T - Weber - 1996 ta 1997.ron... 100%

Extract: UT - Utah County - 2001 and newer.ron.., 100%
Extract: UT - Lkah County - 1996 to 2000Lran... 100%
Extract: UT - Sakk Lake - 2001 and newer ran... 100%
Extract: UT - Salk Lake - 199 to 2000.ron... 100%

Eubumcts 1T Pumaie 1000 2 i v

B Ready-or-Not Config 1.0 Setup =3

Completing the Ready-or-Not Config
1.0 Setup Wizard

Ready-or-Nok Config 1.0 has been installed on your
computer.

Click Finish to elose this wizard.

8. Click "Finish" to exit Setup. The Ready-or-Not configuration utility
will launch automatically.

Ready-or-Not™ User Guide 7



3 Use configuration utility

3.1 Launch the configuration utility

To launch the configuration utility, click on Start—Programs— OBD-II
Software— Ready-or-Not—> Ready-or-Not Configuration Utility.

3.2 Configuration utility interface overview

Main Dialog

When the program starts, you will be presented with the main
program dialog:

B Ready-or-Not Configuration Utility[z]@][g] ° Reqmred MOI’IItO!"S. Check-
box next to a monitor means

that the monitor status must

File Tools Help

Required Manitars Allowed Mat Complzte Monitars ' '

____________ ] be g:omplete in order for the
I AT device status to change to
[~ EWAP Uszer Motification the 'Ready' state.
[~ SEC.AIR | i & Visual |
o2
[~ OZHTR W "Ready’ when MIL on e Allowed Not Complete
[~ EGR i '

Send | Betiove | Monitors. Some states

emissions programs allow
up to three 'not complete'
monitors. The dropdown
box allows the user to select
from 0 to 3 allowed not complete monitors. The value of "0" means
all monitors must be ready.

COmML

>
=
E
=]
>
=
[=
o
(3]
[«]
[72]
>

e User Notification. Can be set to "Audio & Visual", or "Visual Only"
(disables the internal speaker).

e "Ready" when MIL on. The MIL indicates that a component has
failed, therefore in some cases it may make sense to indicate to
the user that the vehicle is ready to be taken back to the shop for
additional repairs, rather than wait for all the tests to complete.

e Send. Sends the current configuration to the test tool.

e Retrieve. Retrieves configuration stored in the test tool.

8 Ready-or-Not™ User Guide



Status bars at the bottom of the dialog are used to display the COM
port number, confirmation of send/receive, and the name of the
currently selected configuration preset.

Menus
The File menu has four options:
e Save — records current configuration to

the currently loaded file. If no file is
loaded, the operation is identical to "Save

As..."
Save As... |—1
Qpen ko e Save As... — allows user to select the
Ext u name for the configuration file.
[~ SEC AR I
- e Open — loads previously recorded

configuration settings.
e Exit — terminates the program.
The Tools menu has two options:

¢ Program Options — displays the

B Ready-or-Not Configuration d .
; & Program Options dialog.

=0 Tools

Help

= Program Qptions Mat .
Reset Factory Defaults b e Reset Factory Defaults restores

=T the default configuration settings,
I EVAP User Notiic which are compatible with most
vehicle inspection programs.

C
(74
o
(2}
o
=]
=
«Q
=
=1
:_.:
<

Program Options Dialog

¢ COM Port Number — select the
Logram Options correct port number for communicat-
COM PotNumber [1 %] ing with the device.

Detect Com Ports ‘ e Show Hints — show helpful hints
when cursor hovers over a user
interface item (button, checkbox, etc).

[v Show hints

e Detect Com Ports — refresh the list

oK.
= of available COM ports.

Ready-or-Not™ User Guide 9
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3.3 Load a configuration preset

The Ready-or-Not configuration utility comes with a library of
configuration presets for all current state emissions programs. To
load a preset, follow these steps:

1. Click File— Open.

2. In the dialog that appears, select the appropriate preset.

Open Ready-on-Not Configuration File

Look jn ‘ ) Ready-or-Mat

L} i] AK - Anchorage ron
) |#) 4K - Fairbanks.ron
MyRecent (2] 4z - 1995 to 2000.ron
Documents |12) 52 2001 and newer.ron
@ ﬂ Chron
3 CT.ron
Desktop [#]Dc - 1996 to 2000.ron
[5]DC - 2001 and newer ran
| DE - 1996 to 2000.ron
BDE - 2001 and newer.ran
My Documents |3 c. 1906 to 2000.ron
= |#) @A - 2001 and newer ron
»11 %10 - 199 to 2000.ron
[2)10 - 2001 and newer.ron
|2]1L - 1996 to Z000.ron

‘:‘)] <

My Computer

=l ® o B~

f_‘] IL - 2001 and newet.ron
[#]1H - 1996 ta 2000.r0n
%] - 2001 and newer.ran
|%]L4 - 1996 ta zo00.ron
.'i]LA - 2001 and newer.ran
%] - 1996 to 2000 ron
3MA - 2001 and newer.ran
[#]MD - 1996 to 2000 ran
[%]MD - 2001 and newer.ron
] ME - 1996 ko 2000,ron
.3] ME - 2001 and newer.ron
%] Mo - 1996 to 2000.r0n
f_‘] MO - 2001 and newet ron
[#]NC - 1996 ta 2000.ron
%] NC - 2001 and newsr.ran

>

Flaces

My Metwork  File pame |AK-Anchnrage ron ﬂ Open

Files of type: |Ready or Not Configuration File ~| Cancel

3. Click 'Open'.

The name of selected preset will now be displayed in the status bar
at the bottom of the main screen.The preset will be automatically
loaded and remain loaded each time the utility is run.

B Ready-or-Not Configuration Utility |._
File Tools Help

Reguired Monitorz

i
[~ EWAP
[~ SEC. AIR
[~ 02

[~ 02HTR
[~ EGR

o
< Al - Anchorage
u

Allowed Mot Complete Monitors
a -

User Motification

| o & Visual |

Iv "Ready" when MIL on

Send | Betrieyve ‘

10
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3.4 Create a new configuration preset

To modify an existing preset, you need to first load it (see previous
section). To create one from scratch, click Tools—>Reset Factory
Defaults.

Then, follow these steps:

1. Make the necessary changes to the preset.

B Ready-or-Not Configuration Utility |'._

File Tools Help
Fiequired M onitors Allowed Mot Complete Monitors
(N~
v CAT
[~ EWAP Uzer Matification
[~ SEC. AR |\-"isua| Oy ﬂ
[~ 02
[~ O2HTR [~ "Ready" when MIL on
[~ EGR
Send | Retrieve |
COM1
Ak - Anchorage

2. Click File-> Save As...

H n H a0
3. Enter the name for the preset in the "File name:" field. %
(]
Save Configuration As... @@ 8
Savein | ) Readp-ortat ~| £f BB~ ?h
- | 3 AK - &nchorage ron E] ID - 2001 and newer ron La.
Lﬁ 5] K - Fairbarks.ron [#]1L - 1996 to 2000.ron c
MyRecent ||=] Az - 1996 to 2000.ron [=]1L - 2001 and newer.ron =
Documents |12 52 2001 and newer.ron [#]1h - 1996 ta 2000.ron =
i % ﬂ CAran ﬂ I - 2001 and newer ron -
=] CTron [=]L4 - 1996 to 2000, ron <
Desktop /30 - 1996 to 2000.r0n %]La - 2001 and newer.ran
[=]Dc - 2001 and newer ron []Ma - 1996 o 2000.ron
[ DE - 1996 to 2000, ran [#]M4 - 2001 and newer.ron
| DE - 2001 and newer.ron ] - 1996 to 2000 ran
My Documents /) ¢ - 1996 to 2000.r0n %MD - 2001 and newer.ron
. =G4 - 2001 and newer ron %] ME - 1996 to 2000.ron
»11 511D - 1996 to 2000 ron [¥]ME - 2001 and newer.ron
My Computer < »
'}3 File name: |my presed j Save
My Metwork,  Save as bupe: |F\ead51 of Mot Configuration File j ﬂ
Flaces

3. Click 'Save'.

The new preset can be shared with other Ready-or-Not users via e-
mail or other electronic means.

Ready-or-Not™ User Guide 1



4 Program the Ready-or-Not

4.1 Connect the test tool to the PC

To connect the Ready-or-Not test tool for programming, follow these
steps:

1. Plug the DB9 male end of the serial cable into the DB9 female
connector of the test tool, as shown:

2. Plug the other end of the serial cable into the COM port of your
PC. Note that the COM port is a 9-pin, male connector.

COM Port

The Ready-or-Not is designed to be powered from the COM port in
programming mode, and does not require an additional power

supply.

Hint: Some third-party USB to Serial converters may not provide
enough voltage for the proper operation of the Ready-or-Not.

If your PC does not have a built-in COM port, refer to the "Accesso-
ries" chapter of this User Guide for information on ordering an
approved USB to Serial converter.

°
o
-
-
0
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4.2 Program the test tool

Once the test tool is connected to the serial port of the PC, follow
these steps:

1. Launch the Ready-or-Not configuration utility (Start->Programs—
OBD-Il Software—>Ready-or-Not->Ready-or-Not Configuration
Utility)

2. Load the desired configuration preset (see section 3.3, "Load a
configuration preset").

3. Click the 'Send' button. The words "Configuration sent" will appear
in the status bar to confirm that the device has been successfully
updated with the new configuration preset. The device is now ready
to be connected to a vehicle.

B Ready-or-Not Configuration Utility g@@

File Tools Help

Fequired Monitors Allowed Mat Complete Monitars
] -

[~ CaT
[~ EWAP User Motification
[ SEC &lR Audio & Visual -
[~ 02 | J
[~ D2HTR [v "Ready" when MIL on
[~ EGR

Retrieve |

COmM1 Configuration sent
MC - 1996 to 2000

If the words "Communication timeout" appear in the status bar, refer
to section 6 ("Troubleshooting") of this user guide.

B Ready-or-Not Configuration Utility E”E|E|
File Tools Help

R equired Monitors Allowed Mot Complete Monitors
2 -

[~ CaT
[~ EWAP Uzer Matification
[ SEC AR Audio & Visual v
[~ 02 | J
[~ O2HTR [v "Ready" when MIL on
[~ EGR

Retrieve |

COM1 Communication tmeout
MC - 1996 ko 2000

Ready-or-Not™ User Guide 13
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5 Use the Ready-or-Not

°

=

S .

= 5.1 Connect the test tool to the vehicle

s

m . .

o — Diagnostic Connector

< — S

° a()) CGEEEEEEED ¢/

(2} —

N

RDY-OR-NOT]
To connect the Ready-or-Not test
tool to the vehicle, follow these
steps:
@ 1. Make sure the ignition key is on, and the

engine is running..

2. Plug the DB9 female end of the OBD-II
cable into the DB9 male connector of
the test tool.

- Wt

READY  NOT READY

3. Plug the other end of the OBD-Il cable into the diagnostic
connector of your vehicle.

Hint: The diagnostic connector is most likely just under the edge of
the dash on the driver's side and will look as pictured on the diagram
above (it is "D" shaped and has 16 positions). In some vehicles, it is
on the passenger's side or even behind a small panel or the ashtray.

When first plugged in to the diagnostic connector, the Ready-or-Not
will perform an LED test (all green LEDs on, followed by all red
LEDs), and emit a short "beep" (unless sound is disabled by user). If
nothing happens when the test tool is connected to the diagnostic
port, refer to the "Troubleshooting" section of this user guide.

The test tool uses very little power in the power-save mode, there-
fore it is safe to leave it plugged into the diagnostic connector for a
few days, even when the vehicle is not being operated.

™
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5.1 Interpret the readiness status LEDs

The "Not Ready" LED will start

flashing slowly, indicating [ i} |
that the test tool is attempting 3 g 5o
to establish communication 000000
with the Electronic Control Unit [ o £ =

READY NOT READY

(ECU). The tool will try to
connect on each of the five
OBD-Il protocols, until it receives a reply from the vehicle.

Normal connection time is between 1 and 25 seconds. If the vehicle

does not reply to requests on any of the five protocols, the "Not

Ready" LED will quickly flash five times, to indicate that it was not

able to connect, and after a 20 second pause, the cycle will repeat. If

connection is not established within about 60 seconds, refer to sec-
tion 6 ("Troubleshooting").

C —J o
P Once the connection is estab-
SoLsss Ilghed, t'hc_a tool vylll request
O o ° = diagnostic information from the
FEADY. NOTREADY vehicle, and display the results

on the monitor status LEDs.
The monitor test results are updated approximately twice a minute. If
the test tool determines that the vehicle is not yet ready to be taken
back to the inspection station, the "Not Ready" LED will illuminate.
ﬁ
READY NOT READY :I
short beeps (unless the test
tool was programmed with the
"Visual only" option). The beeps will be repeated every 30 seconds to

let the driver know that the vehicle is ready to taken back to the
inspection station.

When the test tool determines C

that the vehicle is ready for its

emissions test, it will light the S
"Ready" LED, and emit three O ° o

O o,HR

O eer

QO Evap
Q SEC.AR

O car

Test results will be retained for

— —  five minutes after the ignition is
P S turned off, after which the
5060006060 device will enter the power-

O fos o —] save mode, indicated by the

READY NOT READY

slowly flashing "Ready" LED.
The Ready-or-Not will periodi-
cally wake up, and attempt to reconnect.

Ready-or-Not™ User Guide 15
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6 Troubleshooting

6.1 PC connection problems

This section describes problems that you may encounter while
programming the unit.

6.1.1 "Communication timeout"” error

« Possible causes: Bad connection,

comt wrong COM port selected, bad USB to
MC - 1996 ko 2000 . RS232 converter.

Solution: Check the serial cable, to make sure it is making good
connection with the Ready-or-Not unit, and the PC serial port.

If the unit still fails to connect, check to make sure you are using the
correct COM port. The default number of the built-in serial port is
COM1, however this number may be different, especially if you are
using a USB to RS232 converter.

To display the list of ports available to your :

system, from within the configuration utility,
click Tools—>Program Options, and click the

drOdeWn box. COM Port Number: |1 -

(2]
c
=
o
o
<
0n
o
e}
=}
o
£
-

Detect Com|
If your system has a large number of avail-
able ports (as in the example screenshot), it | & show kint:
is highly recommended that you unplug (or
disable) any Bluetooth devices, and uninstall aK
the Bluetooth software.

Click the 'Detect Com Ports' button to refresh the list, select the first
port on the list, click 'OK', then 'Send'. If the 'Communiction timeout'
error persists, repeat the procedure for the remaining ports, until the
'Configuration sent' is displayed in the status bar.

6.1.2 "COM Port Error"
COM Port Error
Possible causes: Port in use, wrong J
H H C k COML
port selected. improperly installed X PRl

Cancel |

Solution: Close any programs that
may be using the COM port you have
selected in the configuration utility (GPS, HotSync, etc).

16 Ready-or-Not™ User Guide



Make sure you have not accidentally selected a port assigned to
another peripheral (e.g., a modem).

Next, check the port status. Click on Start—>Control Panel, then
double-click the System icon. If the System icon is not visible, click
on the "Switch to Classic View" link (top left).

Click the Hardware tab, then Device Manager.

Find the Ports (COM & LPT) tree, and £/ Device Manager
click on the plus sign to expand it. If |5 & o= =

you see ports with a yellow "warning" _,,3 C L

icon, or a red "disabled" mark next 10 | s e 3
their icon, you may need to reinstall or o paslcomslen (cons
enable the port. Refer to the documen- £GP Printer Part (1PTL)

tation provided by the manufacturer of ;%-3:;:;;:::::;;:ﬂm<C°M2>

your serial por’t card or dongle for ’%i Prﬂ\iﬂcUSE—m—SeriaICﬂmmPnrt(COMH)
instructions. >

6.2 Vehicle connection problems

6.2.1 No startup LED test/beep

Possible causes: Bad connection, ignition off, blown fuse

Solution: Make sure the OBD-II cable is firmly plugged into the
diagnostic connector (DLC), and the test tool. Verify that the ignition
key is in the KOER (Key On, Engine Running) position. Check the
fuses (the DLC often shares a fuse with the cigarette lighter socket).

6.2.2 Unable to connect
Possible causes: Bad connection, ignition off

Solution: Verify that the OBD-IlI cable is firmly plugged into the
diagnostic connector (DLC), and the test tool. Make sure the ignition
is on, and the engine is running.

6.2.3 Flickering "Not Ready" LED, rapid beeping
Possible causes: Damaged unit

Solution: Note which of the six LEDs is lit, and contact the Support
department (see section 7, "Support Information").

Ready-or-Not™ User Guide 17
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7 Support Information

Please be sure to read section 6 ("Troubleshooting"), prior to
contacting ScanTool.net, LLC for support. Many of the common
problems can be solved by following the simple steps outlines there.
When you contact Support, please have the following information
ready:

. Operating system of your computer

. Your invoice number

. Serial number

. Hardware version

. Firmware version ks Promram

. Version of the configuration utility S S

. Whether or not a USB to RS232 Ready-o r-Not
converter is used

NOORNWN=

Configuration Utility

ltems 3 through 5 can be found on the
label on the back of the Ready-or-Not unit:

ScanTool.net, LLC

1819 W Rose Garden Ln
Suite 3

Phoenix, AZ 85027
(866) 923-1870

www.Ready-or-Not.us
US Patent No. 7,012,512

Pii: 430101 FivY. SELEW. TEER Copyright ® 2007 ScanTool net, LLC
IO e -

ltem 6 can be found by clicking
Help—About this program from within the configuration utility.

Visit us online to receive up-to-date information, download updates,
or request help from our support department:

=
2
=)
©
£
1
O
Y=
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http://www.ready-or-not.us Ready-or-Not website
http://www.scantool.net/support Online support system
http://www.scantool.net/forum User forum

You can also contact us by postal mail, fax, or telephone:

ScanTool.net, LLC
P.O. Box 81441
Phoenix, AZ 85069

Phone: (623) 582-2366 Mon-Fri 9am to 5pm MST

Fax: (602) 297-6901 Sales Department
(602) 532-7625 Other inquiries
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8 Accessories

8.1 OBD-Il cables

The Ready-or-Not can be used with a number of inexpensive OBD-I
cables, including cables with right angle J1962 connectors.

The ability to replace a worn out OBD-Il cable is indispensible in
heavy use applications. You can place your order online, by phone,
or fax (see previous section).

5.2 USB to RS232 converter

Some modern PCs (especially portable computers) do not have a
serial port, necessary for programming the Ready-or-Not. The
solution is to use a USB to RS232 converter, which plugs into any
available USB port, and creates a virtual COM port.

Important: The USB to RS232 converter must be used with the
serial cable supplied with the Ready-or-Not.

SO110SS929Y

A word of caution: Some commercially available USB to Serial converters do
not meet the RS232 voltage and current specifications, and will not work with the
Ready-or-Not — despite the fact that they often cost significantly more than the
competitively priced serial converters available from ScanTool.net, LLC.
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PROPER USE,
SAFETY REQUIREMENTS,
AND LIMITATION OF
LIABILITY

The purpose of the Ready-or-Not Test Tool is to determine the readiness
status of a vehicle for a state mandated inspection.

All normal safety precautions while working around vehicles should be
observed. Users of the Read-or-Not Test Tool MUST completely review this
Operator's Manual prior to use. Always comply with all safety requirements,
procedures, and recommendations in this manual while testing vehicles with
Ready-or-Not Test Tool. Never view the device while the vehicle is in
operation. Always ensure the motorist is aware of the installation of the
Ready-or-Not Test Tool, and ensure that the tool and any cabling does not
impede the operators use of the vehicle. Users must be observant and use
common sense.

By accepting delivery of and using the Read-or-Not Test Tool, the end user
agrees ScanTool.net, LLC will not be liable for any fatality, injury, or property
damage, whether direct, indirect, incidental, special or consequential
(including but not limited to loss of income or profits), caused by the use or
operation of the Test Tool, or caused by any act or omission of a User or any
other person. The User of the Test Tool is solely responsible for its proper and
safe operation.

ScanlTool.net

Inexpensive solutions for OBD-Il diagnostics



